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Introduction 
SMART eResources (SMART eR) is a web application that allows employees access to 

their own information.  It is up to the district to decide what to implement to meet their 

needs. 

Logging into SMART eR 
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For new employees and employees who have never logged into SMARTeR the User ID 

is your employee ID number.  The Password is the District number plus the last 4 digits of 

your social security number (no spaces). 

 

District:  Verify the district number displayed in this field is your school district.  If not, 

change the dn=xxxx in the URL to select your district number. 

  

Once logged in employees are required to change their password and setup a minimum of 

three (3) question choices. 

  

 Password:  The new password cannot be the same as your old password and must be a 

minimum of eight (8) characters in length and must contain at least one upper case letter, 

one lower case letter, one number and one symbol (e.g. John1deere$ or Smart#1234).   
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 Security Question:  The security question will allow the employee to use the “forget 

password” link to reset their password should they forget it.  Users will have the option to 

select predefined questions, type in customized questions, or a combination of both.   

 

The system will randomly choose one question from this list of questions for the user to 

verify at time of login.  If answered correctly the user will be logged in.  If incorrect, an 

additional two tries will be provided before the account is locked for account safety.  The 

user would then have to contact the appropriate district staff to have the lock removed. 

 

 

Please make sure Javascript is enabled for your browser for SMART eR to work correctly 

in Internet Explorer 10 & 11.   If it is not enabled you will get the following screen: 

 
 

After successfully entering a login id and password, the system will redirect you to a 

security question setup page.  All fields with a colored background need to be entered in 

order for the page to save. 
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When your changes have been saved successfully, the following message will display. 

 

 

 

Once “OK” has been selected you will return to the login window and required to log in 

using your new password. 
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It will then display a security question.  Enter an answer correctly and the system will finish 

logging in. 

 

 
 

Note: 

1. If you are locked out and have security questions setup – You can use the Forgot 

Password link to reset your password.  You will be asked to answer one of your 

security questions. 

2. If you provide the correct User ID and Password, but forgot the answer to your 

security question – Close out of SMARTeR and re-login.  This will trigger a new 

security question. 

3. You have 3 attempts to login successfully before you are locked out.  If you have 2 

invalid attempts to get in and then successfully submit your username and 

password, you will have 3 attempts to answer your security question before you are 

locked out. 
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Changing Password and Security Questions 
 

Password and Security Questions can be maintained or changed using links provided in 

the upper right corner of the Home page. 

 

Select Logout to exit SMART eR. 

 
 

Announcements and District Forms 

Announcements, Notifications, District Forms and/or Employee Forms appear on the 

Home page.  This module provides a way for Administration to send electronic 

announcements and notices to employees which are visible once the employee has logged 

into SMART eR. 

Once you are logged in, the Announcements page will be displayed. 

Below is an example of what is displayed.  Any “Announcements” sent to the employee 

will be referenced on this page.  

Click on the “View” button and the message will display in the message box section. 

To delete old messages that you are no longer interested in click the “Delete” button. 
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To access any forms that have been attached, click on the “District Forms” button. Click 

on the “View” tab to view and/or print the forms. 

 

 
 

 

 

Favorites are automatically saved on the top left of the homepage. 

 

 
 

SMART eR Menu Items Defined 

Navigating SMART eR 

The Home page will be the same for everyone.  It is the main page which SMART eR 

starts from. 

Key Menu Items include: 

A- My Frequent Places:  This feature will track the pages visited most frequently by the 

employee.  It will list the top 5 most accessed places.  The pages/reports are also available in 

the normal menu.  The user will see nothing until they access a page. 

B- Home:  This feature allows the employee to directly access the two most frequently used 

pages; Pay Stub and TimeOff.  The page displays the most current values available.  Detail can 

be viewed by clicking on the link to View Detail.  Old pay stubs can also be found under the 
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link.  If a user has not been paid, or the district is not using TimeOff, then the box will not 

display. 

C- Logged in as:  All employee maintenance for SMART eR is located in one place.  The links to 

Change Password or Security Questions will always display on the Home page so they are 

easy to find.  We RECOMMEND that users logout of SMART eR if on a public computer to keep 

their data safe. 

D- Menus (left sidebar):  Menus can be opened or closed by clicking on the ‘+/-’ sign.   SMART 

eR automatically opens to an employee’s information to save them clicks. 

E- Browsers (bottom of page):  The browsers supported for the current release of SMART eR 

can be found at the Visit our About page link.  These are adjusted every release based on the 

users accessing SMART eR statewide.  
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Pay and Personal Information 
Pay and Personal Information is available to all employees. This allows the employee to 

view their personal information.  The district also has the option of allowing employees to 

update their information online such as addresses, phone numbers, email addresses, 

dependents, emergency contacts, licensure and training. This will then update the 

information in the SMART database.  

TimeOff 

TimeOff and Pay Stub are displayed on the Home page.  The page displays the 

most current values available.  Detail can be viewed by clicking on the link to View 

Detail.   

 This allows you to view the TimeOff plans, balances and usage. 

From “Home” page, select “View Timeoff Detail” 

 
 

It will open the TimeOff Information.   

 Use the drop down box to select a different year to view 

 Click  ‘+’ to view detail 

 Click ‘-‘ to hide detail 

 

 
To print your entire Timeoff, click on the Print Timeoff Detail button. 

This screen shows the 

different TimeOff Plans 

that are available to the 

employee. 

 

Time off information 

from prior years can 

also be viewed by 

selecting the 

appropriate date range. 
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Pay Stub 

Pay Stub and TimeOff are displayed on the Home page.  The page displays the most 

current values available.  Detail can be viewed by clicking on the link to View Detail.  

Year-to-date pay information can be viewed by clicking on the link to View YTD Pay. 

 This allows you to view your current and old pay stubs as well as your Year to Date 

Pay and your specific Pay Information. 

From the “Home” page, click on the “View Pay Stub Detail” 

 
 

 View Pay Stub Detail 

 
 

To save the Pay Stub/print only that information, click on the Print Entire Pay Stub 

button.  This is the formal report that can be printed when applying for a loan from a 

bank or needing any other official documentation.  Caution:  on a public computer – this 

will save it to where the browser default saves to unless you specify somewhere else.  

Typically it is to the “downloads” folder. 

 

An Adobe document will ask to open. 

This shows the 

detail of the last 

processed payroll. 

By clicking here a listing of all previous 

pay periods will appear. 

This shows the detail 

of the timecards 

processed in this 

payroll. (This may 

not appear if not 

paid by timecard as 

in sample picture.) 

New links to help determine what your 

withholdings should be set to. 

This shows where and how much was 

deposited into the employees account. 

New option to 

preview pay stub 

and will NOT save 

to the computer – 

scroll down to see 

entire document. 
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You can choose to open it or save the file. 

 

 
 

 

 

 

To get to older paystubs, click on the Other Pay Stubs button.   

A list will appear to choose from.  

  

If the employee simply wants to know 

what their deposits were by calendar year, 

they can use the drop down box to select 

the year.  This will display Net amounts 

by check date.   

If you wish to see more detail, click on 

the date/amount for the particular pay 

period and the detail for that pay period 

will be displayed. 

This area shows what 

type of pay and the 

gross amount of pay 

for the specific pay 

period.  If the 

employee earns 

multiple types of pay 

each pay will be 

shown separately. 

This section shows the amount of District 

match that the employee is eligible for 

under their work agreement. 

This area shows 

deductions and 

the amount 

withheld from 

the employee’s 

pay check.  

These deductions 

along with the 

amounts 

withheld for 

state, federal and 

FICA taxes are 

subtracted from 

the gross pay to 

get to the 

employee’s net 

pay. 
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Year to Date Pay 

 
From the “Home” page, click “View YTD Pay” 

 

 
 
 

 
For help on choosing your withholdings, the links to the Federal and MN withholding calcuators 

are provided at the top. 

 

Any deduction 

followed by an 

“*” is a pre-

taxed deduction. 

This screen shows the employee the 

calendar year to date info. To see a 

different year, click on the drop down box 

and select the year you wish to view. 

This screen gives the employee the year to 

date information on pay, taxes, deductions 

and district paid benefits. 
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Personal Information can be accessed under the Home menu | My Information.  Listed 

beneath that are two additional menus allowing employees to view their personal 

information; Payroll Items and About Me.  The district also has the option of allowing 

employees to update their information online. 

Payroll Items 

1. Payroll Items 

a) Contract Information 

b) Direct Deposit 

c) Pay Information 

d) ACA Form 1095 

e) W-4 

f) W-2 

 
 

 

Contract Information 
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Direct Deposit     

Employees can view their district deposit information online.  If allowed by the District, 

the employee can change the amounts allocated to their bank account(s) online.  An 

electronic signature is required.  Districts determine how many accounts each employee 

can enter.  Changes made will not be active until it is signed by the employee and then 

moved into payroll through a batch job which is scheduled to run once a day. 

 

An Electronic Signature is required.  The employee is asked to authorize the change and 

verify their identity.   
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The employee can view an example of where to locate the routing number and account 

number by clicking on the View Check Example button. 

 
 

Pay Information 

Employees can view their pay information online.  Below is an example of a teacher’s 

information for their basic assignment and additional pay.  Employees can view 

information from prior years by using the drop down box to select a different year. 

 

 

ACA Form 1095 

Employees can view and print their 1095 information.  The first time a user goes to the 

ACA Form 1095 page, the “Consent” message will come up.  If the employee consents 

Yes the IRS allows the employer to furnish the form electronically.  Generally, this means 

the employee will receive their form sooner than a paper form, and be more convenient for 

them as well.  Employees can view prior years by using the drop down box to select a 

different year. 
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The most current form will now be available for preview on the page.  To save a copy of the 

report or print it, click on the View Form button circled above.  Caution:  on a public computer – 

this will save it to where the browser default saves to unless you specify somewhere else.  

Typically it is to the “downloads” folder. 

W-4 and W-2 

Employees can view online what is currently being claimed for tax withholding based on 

their completed Form W-4.  The Form W-2 and W-2 Information sheet can also be viewed.  

If the employee has not consented to receiving the W-2 electronically the option to view 

or print their W-2 is not available. Once the user has consented to an electronic W-2 both 

the current and prior years can be viewed. 

 

W-4 
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Change W-4 Withholding Amounts 
 

Districts can allow an employee to change their W-4 withholding amounts online for both 

federal and state reporting.  An Electronic Signature is required.  The employee is asked to 

authorize the change and verify their identity.  See Page 14 – Direct Deposit – for an 

example of this process.  Changes will not be active until it is signed by the employee and 

then moved into a payroll date waiting to calculate.     

The employee can view an example of the Federal or State W-4 by clicking on the View 

Blank W-4 button, as applicable. 

 
 

W-2 
 

In order to view and print your W-2 on-line you must consent to Electronic W-2’s when 

you access this window. 
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The form selected will now be available for preview when clicking on the “Go” button.   

 

From the preview page, to save a copy of the report or print it, click on the “Print W2” button.  

Caution:  on a public computer – this will save it to where the browser default saves to unless 

you specify somewhere else.  Typically, it is to the “downloads” folder. 

 

W-2 Information Sheet 
 

W-2 Information Sheet is available to all employees, even if the employee has not 

consented to an electronic W-2. 

 

 
 

 

The About Me group can be accessed under the Home menu | My Information.  This 

section contains the employee’s personal information, emergency contacts and dependent 

information. Districts have the option of allowing the employees to make changes to this 

information. 

About Me 

2. About Me 

a) Dependents 

b) Education 

c) Emergency Contacts 

d) Employee Information 

e) Licensure 
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Dependents 

 
 

 

Education | Continuing Education 

This screen allows the employee to view the information the district has on file for their 

education along with continuing education credits (e.g. Lane Changes).  

 

This screen will show you who the 

district has listed as your 

dependents.  

The district has the option of 

allowing the employee to make 

changes to this information. 
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Emergency Contacts 

 
 

 

 

 

 

 

 

Employee Information | Address 

                             
 

Employee Information | Contact 

 

This is where the District would like all employees to add, update, or delete 

the individuals they would like contacted in the event of an emergency 

situation. If there are contacts in the district’s database, they will be listed 

here. 

The employee can also change the information that is currently listed by 

clicking on the “Edit” button (if visible). 

The employee can then make the changes and save. If there is a contact that 

is no longer valid, the employee can select that contact and delete it. 

This screen shows the 

current information that 

the district has on the 

employee.  

The district has the 

option of allowing 

employees to make 

changes to their address. 

There is also additional 

information that can be 

updated by the employee 

if the district chooses to 

make that option 

available. 
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Employee Information | Other 

 

Medical Information 

 

Licensure | Teaching Licenses 

Teaching license information is viewable here, including expiration dates.  A link to the 

MDE website is provided so the employee can view their record on file with the State of 

Minnesota. 

 

Licensure | Other Licenses/Certifications 

This section tracks other licenses and certifications such as Asbestos Certification, Boiler 

License, CPR certificate, Driver’s License, Occupational Therapist, and Registered Nurse. 

 
 

 

Training, Tests & Skills 

Training, Tests & Skills can be viewed in this window.  
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Requests 

Requests includes Ordering, Leave of Absence Request and Vehicle Request.  This 

group can be limited to specific employees through secured access.  Region V will set up 

user access based on the request made by the district administration.  

Ordering 

This is a web-based system for non-SMART Finance users to enter purchasing 

information and perform all the functions related to Purchasing.  SMART eR currently 

offers two different methods for authorized users to request and/or place orders that 

transfer into SMART Finance:  Ordering and Order Requisition Entry. 

 

 
 

 

 

Ordering 

The first method is Ordering for specific outside vendors via a “punch-out” system.    The 

authorized employee chooses from a predetermined list of approved vendors.  They are 

able to go to the vendor’s website and place items in their “shopping cart”.  They transfer 

To create an Online 

Order Request, click on 

Order Requisition 

Entry.  

Key in the information 

and route for approval.  
Ordering allows the user to punch out to 

a vendor’s website.  

Additional 

Training, 

Tests and 

Skills can be 

used to track 

other types of 

training for 

staff and the 

date the 

training was 

completed. 
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their cart of goods into a requisition or purchase order.  Once the purchase order is 

approved, the order can be electronically transferred back to the vendor via SMART eR. 

 

 

Order Requisition Entry 

The second method is the Order Requisition Entry which allows an order request in 

SMART eR to be created and routed for approval, then transferred into SMART Finance 

purchase order processing.  They do not go to a vendor’s website for this process.  They 

simply choose an active vendor from the list and key in the items they are requesting.  The 

request is transferred into a purchase order after approved. 

 

Responsibilities 

The Responsibilities group includes Vehicles and Supervisor’s Report of Accident.  Like the 

Requests group, it can be limited to specific employees through secured access.  Region V will 

set up user access based on the request made by the district administration.  
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Supervisor’s Report of Accident 

Supervisor’s Report of Accident (SRA) is used to notify the district office of an injury. 

Supervisors can be given access to this page to complete the form. A confirmation email is sent 

to a designated person to let them know that an SRA has been completed. The information from 

the SRA will auto-populate the First Report of Injury (FROI) report in SMART HR. The SRA is 

often used by the Worker’s Comp Company to investigate a claim. 

 
 

Change Password and Security Questions 

 

In the top right of the home page, you will find profile options. 
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Logout 
In the top right of the home page, you will find profile options.  Select Logout to exit 

SMART eR. 

 

 

You can change 

your password 

and security 

questions on 

this page. 

In order for an 

employee to reset their 

password three (3) 

security questions must 

be setup.   

An employee can set 

up one, two or three of 

their own questions, or 

choose the “Pre-Setup 

Questions”, or a 

combination of these 

two options. 

Three (3) questions 

must be set up. 


